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Introduction 
Welcome! This user guide will introduce you to Degree Works, a web-based system designed to assist students and 

advisors in monitoring academic progress towards degree/certificate requirements in an easy-to-read worksheet format. 

All students attending any of the three NOCCCD campuses (FC, CC, NOCE) to fulfill degree/certificate requirements can 

use Degree Works. 

Login Process 

 

1. Enter your 8-digit Banner ID number (ex: 00123456) in the MyGateway ID field 

2. Enter your password in the Password field 

3. Click the Login button to continue. If login is successful, your myGateway home page will appear. 

4. Click the Faculty link in the main menu panel on the left side of the page to display the Faculty page 

5. In the Faculty Links section, click the DegreeWorks SSO link 

   

6. The Degree Works main page will display 

Student Access 
1. After successful myGateway login, click on the Student link in the main menu to display the Student page 

2. In the Student Links section, click on the DegreeWorks image link (see below) to access Degree Works. 
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Degree Works Main Page 

 
The Degree Works main page consists of three areas, in addition to the FERPA compliance notice: 

 Navigation Toolbar 

 Student Summary Toolbar 

 Worksheet Area 

Navigation Toolbar 

 

The above toolbar will display at the top of every Degree Works page. 

Option Description 

FAQ View campus-specific Frequently Asked Questions (FAQ) pages 

Help Create a campus-specific District Help Desk request 

Print Print the currently displayed web page 

Log Out Exit Degree Works 
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Student Search/Summary Bar 
This bar is used to search for a student. When the student is located and selected, his/her information will display in the 

remaining fields of the bar. 

 

Field/Icon Description 

 Student Finder button to search for a student if Banner ID number is not known 

Student ID Enter the student’s Banner ID number, if known. Start with @ symbol first. 

 Displays student’s name. Use arrows to view students in a selected group, if available. 

 Refreshes selected student’s information from Banner 

 Displays any notes entered for the selected student 

The following non-editable fields displays selected student’s information 

Degree Displays current degree 

Major Displays current major 

Campus Displays current campus location 

Last Audit Last date audit was performed for student in Degree Works 

Last Refresh Last date and time the audit was refreshed from Banner 

 

Example: After entering a valid student ID (starting with @ symbol), the selected student information appears: 

 

Student Finder 
The Student Finder is a tool to search for students based on a set of criteria. The Student Finder can locate a student, 

student populations (a specific major/program for instance), or a group of students meeting any combination of available 

criteria set. To access, click the Find button at the far left of the Student Search/Summary Bar. 
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To search for a student, either: 

a. Enter the Banner ID number (start with @ symbol) in the Student ID field or 

b. Enter first and last name of the student in the respective fields (Use the @ symbol for wildcard searches) 

Press the Enter key or click the Search button to start. Search results will appear at the bottom of the page. 

If multiple student names appear, click the Uncheck All box at the bottom of the listing, find and click the box next to the 

desired student, and click OK. The selected student and information will populate the appropriate fields in the Student 

Search/Summary Bar. 

To search for a group of students meeting a set of criteria: 

1. Select the criteria from among the available categories. Each category is limited to one selected criteria. 

2. As each criteria is selected, the criteria will appear in the Chosen Repeatable Search Criteria list box 

3. To remove a selected criteria, find and highlight the criteria in the Chosen Repeatable Search Criteria list box and click 

the Remove button 

 

4. Once all desired criteria are selected, click the Search button to start. 

5. Search results will appear at the bottom of the page 

6. Edit the search results, excluding students as needed 

7. Click the OK button to import the records into the Student Search/Summary Bar 

8. Use the arrow buttons appearing above the Name field (see screenshot below) to view each student in the selected 

group and make a selection. The Name drop-down menu can also be used to view the entire list of imported student 

records for selection. 

 

Notes 

 If a student is newly admitted, he/she may not be in the Degree Works system yet. Please contact Degree Works 

Support if you need to review an audit for a newly admitted student after receiving a “Student Not Found” error 

message. 

 A student may have multiple programs because they are attending multiple colleges. Use the Degree  

pull-down menu to change to a different program if available. 
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Worksheets Tab 
This tab is the default view for students when they log into Degree Works and used to review their academic progress. 

Note that the student cannot make any changes to this information. Any change to the program or major is done by a 

counselor. 

 

Formats 
Other worksheet formats are available to view for the selected student. Click the Format drop-down box in the Worksheet 

tab and make a selection. 

 

Registration Checklist 
This worksheet format will display the remaining courses needed to satisfy program or degree requirements. 

 

Click on any listed course in the worksheet to display their respective catalog description and any prerequisites. 
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Diagnostic Report 

This report is a tool used to troubleshoot issues with an audit on the selected student. 

 

Process New 
This function will update the selected student’s worksheet in the event there are recent changes to the scribing for the 

major. Note that a new audit number is generated when the Process New function is completed. 

 

Legend 
The legend, located on the left and near the bottom of the main page, is useful for understanding how the student 

information is displayed and categorized to the viewer. 

Complete: Once a requirement is met, the box appears as checked in a green color 

Complete except for classes in-progress: Registered courses meeting a requirement for 

completion will display as a blue box containing a tilde (~) symbol 

Nearly complete: Registered courses that qualify as part of a multi-course requirement will display 

as a blue box containing the approximate (≈) symbol 

Not complete: A requirement that has not been registered for and completed 
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Save as PDF 
The Save as PDF option will save a copy of the current worksheet in a format that can be electronically distributed. This 

format is read only and does not allow any changes to be made after creation. 

Select a view from the Format drop-down box and click on the Save as PDF button. A new window will appear with the 

PDF document displayed. Note: The Diagnostic Report format cannot be saved as a PDF. 

 

Click the down arrow at the top of the new document window to save to your PC or other storage device. 

 

Class History 
This option provides a compact list of academic history, including grades. It is useful for determining which classes the 

selected student has taken. It cannot be used in place of an unofficial transcript. 
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What If Scenarios 
What If scenarios are used by students and counselors to explore academic goals that are different those currently 

declared. A What-If can be done on any program currently active at any of the campuses (FC, CC, NOCE). A What If does 

not change the declared program or any student information in any way. 

 

Above is the What If audit screen, which allows for an audit to be performed on the selected changes to the student’s 

academic goals. The audit will display how the selection(s) affect the student’s progress, applicable classes to the new 

degree, classes that will not count, and new classes necessary. 

Follow these steps to start a What If audit: 

1. Click on the What If link in the Worksheets tab to display the What If audit screen. 

2. Select the desired changes in the available criteria for the Select your primary area of study section 

3. If necessary, select the desired change for Select your additional areas of study section 

4. If necessary, add any courses being considered for a future term in the Choose your future classes section 

5. After selecting the changes, click the Process What If button to view the new requirements for the student or the 

Save as PDF button to view the audit and save (see previous Save as PDF section) 

 

To view another What If scenario, click the Back button and restart the process. 
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Look Ahead 
The Look Ahead feature will display an audit showing courses a student plans to register for and complete in future terms. 

 

Follow the steps below to generate a Look Ahead audit: 

1. Click on the Look Ahead link located above the Legend section on the left side of the page 

2. Select the appropriate format to display (default is Student View) 

3. Enter the subject short name in the Subject field and the course number in the Number field 

4. Click the Add Course button. The course name will appear in the Courses you are considering column. 

 

5. Repeat Step 4 for all courses to be included in the Look Ahead audit 

6. To remove a course entered, highlight the course in the right column and click the Remove Course button 

7. When all courses for the Look Ahead audit are entered, click the Process New to start the process 
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8. The results of the Look Ahead (Student Display) audit will display showing the planned courses and the requirements 

satisfied (outlined in red) toward the student’s degree/program completion. 

 

9. To perform another Look Ahead audit, click the Back button located at the top of the report 

Note: If a subject name and/or course number is not valid, a note will display at the bottom of the Look Ahead audit (see 

example below). 

 

 

Planner Tab 
The new version of Degree Works transitions to a different method of creating and managing student plans. The older 

method using the Planner tab is now in a Read Only mode (see screenshot below). This tab will display the current student 

plan (if any) in several non-editable views. Please use the Plan tab to create/edit student plans moving forward.  
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Plans Tab 
The Plans tool is used to create a Student Educational Plan (SEP) with a student. Using the Plans tool, a student or 

counselor can create an academic plan for the course of study. Once a plan is established, an audit can be generated to 

evaluate degree progress of the student. 

Click on the Plans tab at the main student screen to access the Plans tool. If an active SEP exists, the plan will display 

automatically as the default view. 

 

Plan List 
The Plan List displays all plans created for the student, regardless of degree, school, or status. Plans can be sorted by 

clicking on the double arrow in each column header. 

To view the Plan List click the View Plan List button located above the Student Planner heading to the right. 

 

To view a listed plan, click to highlight a plan and select an option from the View drop-down menu. If none of view 

options is necessary, double-click a listed plan to display the default view. 

 

To add a new plan, click the New Plan button. Please note that any existing plans for a student cannot be removed. 

Important: Do not edit any existing student plan. Instead, create a new plan with the changes and replace. Refer to the 

Save Plan and Active/Locked Plan sections appearing later in the user guide for more detailed information.  
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Creating a Plan 
If no plans available for the selected student or wishing to create an additional plan, a message will display prompting the 

user to select a plan choice. 

 

Click the Blank Plan button to start the process. 

Note: As of this user guide version, templates are not available yet. All new/additional plans must be created from scratch. 

Student Planner Information  

The first section that appears is Student Planner Information.  

 

The default view upon starting a new plan is Edit. The other options, complete with different appearances, will be 

addressed later in the user guide. 

 

1. Use the Degree Works applet (see next section) to generate the appropriate text to be copy/pasted into the 

Description field. 

  

2. Check the Locked checkbox.  

3. Check the Active checkbox at counselor discretion on whether the plan is intended to be followed 

Note: Only one plan can be designated as Active. 

4. Select the appropriate plan option in the Plan Type drop-down box 

 

Important: A Comprehensive Plan must include all of the coursework and terms needed for a student to complete his/her 

program AND be at least two terms in length. 
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Degree Works Applet 
To ensure consistency in the SEP Description, Degree Works Applet to generate the proper description based on date 

and counselor name. Note that the applet is campus specific, so check and make sure the proper one is being used. If 

necessary, contact your campus SSSP office to obtain the applet and install directions. 

 

1. Launch the Degree Works applet (titled DW Notation Applet) 

2. The Date field should is set to the current date. If another date is desired click on the calendar icon to the right of 

the listed date and set. 

 

3. Find and select your name in the Counselor drop-down list box. 

 

4. Click the Copy/Clipboard button at the bottom of the applet 

5. Click the Description field in the plan and press CTRL-V on your keyboard to paste the generated description 

Note: The applet is programmed to be “on-top” while active, which means it will always be visible regardless of other 

applications or documents that are currently displayed. To exit, click the red X button at the top of the applet. 
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Add New Term 

To add a new term, click the green + button at the top right of the Student Planner Information section. Choose the 

desired term from the Add Term list that appears. 

   

Once selected, a new section will appear in the plan with the chosen term in the header. 

 

Options in the new term section header: 

 Expand/collapse the term course list by clicking the blue arrow appearing to the left of the term name. 

 To change the term, click on the Reassign button and choose from the list appearing underneath the term name on 

the left side 

 

 To delete the term section (and all contents within), click the Delete this term button and confirm 

Add Term Requirement 
To add a requirement to a term, click the green + button in the term header. Choose the desired requirement from the 

Add Requirement list that appears. 
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Choice Requirement 
This plan item is used where a group of courses can satisfy a single requirement. There are two types of Choice 

requirements supported, standard and free form. 

Standard 

Select this type if there are a limited number of specific courses necessary to satisfy a requirement. For a broad category 

of courses within a subject or category eligible to satisfy a requirement, use the Free Form type (see next section). 

1. Select the Choice option if there is more than one course that can fulfill the requirement 

 

2. Click on the ellipses button (…) to display the course selector 

 

3. Type in the name of the course (Example: ENGL 103_F)  

 

To search for a course, click the magnifying glass to the right of the Course entry field. Begin entering the course name 

until a search results list appears. Scroll through the list and select the desired course to add. 
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At this point, there are two options to satisfy different requirement combinations: 

 Click the Add another option button to add another course that can satisfy requirements (Step 4) or 

 Click the green + button to pair with another course in order to satisfy requirements (Step 5) 

 

4. To create a choice where multiple courses can satisfy a requirement, follow these steps: 

a. Click the Add another option button 

b. A new Course entry field will appear. Type the course name in the entry field 

 

c. If there are more courses to add, follow steps a and b 

d. Click the red – button beside a course to remove from the requirement 

e. Click the Done button to view the entire choice requirement 

 

f. If the choice requirements needs more editing, click the ellipses button (…) and repeat Steps 3-4 as necessary. 

5. To create a choice where a course paired with another will satisfy a requirement, follow these steps: 

a. Click the green + button next to the course entry field. Note the requirement adds an AND connector and 

Course/Lab entry field. 

 
b. Enter a course name in the Course/Lab entry field 

c. If another course or combination of courses can satisfy the requirement, click the Add another option and 

repeat Steps 3-5 as necessary. 

d. Click the Done button to view the entire choice requirement. 

 

e. If the choice requirements needs more editing, click the ellipses (…) button and repeat Steps 3-5 as necessary. 
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6. Type in the appropriate value in the Minimum Units entry field 

7. If any additional details are necessary for the choice requirement, click the Notes button to attach 

 

Free Form 

The Free Form type is used to identify a set of courses within a subject or category that satisfies a single requirement. 

1. Click on the green + button located at the top right of the Term heading and select the Choice option  

2. When the Choice Requirement item is added, click on the Choice Requirement field to display the entry box. 

 

3. Enter the Free Form text in the Course field in the following format: 

a. Start by typing the @ symbol 

b. Type the first phrase after the @ symbol (no space) in upper case  

c. Type a space and then the second phrase in upper case 

 

Other examples: @ANY PE_COURSE, @AREA B1_CSUGE 

4. Click the Done button at the bottom of the entry box 

5. The Free Form text will appear in the Course Requirement field. Note that courses entered in this manner will not 

appear in the audit section of the plan. 
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Add Course Requirement 

To add a course requirement to a term, use one of two entry methods: Manual or from Course List 

Manual Entry 

1. Click the green + button in the term header and select the Course option from the Add Requirement list that appears. 

 

2. Type the name of the course in the Course Requirement field 

Note: The course name contains up to four letters. The course number is five characters in length, so can appear in several 

formats, such as 100_F or 110AC. The course name and number are separated by a space. No other place within the 

course name can contain a space. Additional spaces are represented by underscore characters. 

3. The course unit value will appear in the Values field with the next action performed 

4. If there are any comments to add regarding the course requirement, click the Notes icon and enter them there. 

5. If a search is necessary for the course name, click on the magnifying glass icon to display the search box. Begin typing 

in the course name in either the Course or Title fields until a search results list appears. Scroll through the search 

results list and select the desired course.  

 

The selected course and units will appear in the respective fields  
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Course List Entry 

1. Click on the blue slider that appears in the scrollbar on the right side of the page. Look carefully, as it can easily be 

mistaken as the page slide bar.  

 

2. Once clicked, a fly-out list box will appear displaying a list of courses divided into two categories: Still Needed (for 

academic progress) or Courses (all other available courses).  

3. Clicking the blue buttons beside a category/sub-category will expand/hide the eligible courses. 

    

4. Find the desired course to add. Drag and drop into the term heading or within the area 

5. The dragged course will appear at the bottom of the course list in the selected term 

 

Note: The course list box can be displayed at any time in the new plan worksheet for reference. However, the  

drag-and-drop operation can only perform an Add Requirement action. 
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Add Placeholder Requirement 

A placeholder can be added to the term to designate a comment or item outside of the Course or Choice requirement. 

Click the green + button in the term header and select the Placeholder option from the Add Requirement list. 

 

Click on the Select drop-down to display a list of available items.  

 

Selected item will display in the Placeholder Requirement field. Enter any additional information in the Value field. 

 

Moving Items 

Items in a plan can be moved to a different location within the plan using the drag and drop method.  

 

Locked/Active Plan 
All plans created by a counselor must be locked to prevent additional edits by the student. To lock a plan check the 

Locked option. Check the Active option at counselor discretion if the plan will be followed moving forward.  
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Saving a Plan 
To save a plan, click on the Save button in the lower right corner of the page. Plans can be saved at any time and will then 

show in the list of existing plans for a student. Click on the View Plan List button to view all saved plans for the student. 

 

If another active plan exists for the student, a message box will appear stating that the new plan can only be saved in an 

inactive state (Active checkbox is unchecked).  

 

In this instance, deactivate (uncheck Active option) the current active plan first before saving the new plan as active. 

View Audit 
Click the Audit button at the bottom of the Plan to view the planned courses in the student’s current program. This is a 

great way of “closing the loop”. The students can view all planned courses and a plan to follow to reach their goal. 

All planned courses are indicated in the audit with ‘PLAN’, as well as the unit value and planned term. 

 

The audit can be printed by clicking the Print link near the top right of the report. 

 



 

     P a g e  25 | 28 

 

Calendar View 
A student’s plan can be viewed in the Edit (enter and make changes to a plan) or the Calendar view. The Calendar view 

displays a created plan organized by year and semester. Click the View drop-down box and select the Calendar option. 

 

 

Note: Comments entered in the Edit view do not appear in the Calendar view.  

Hover the mouse pointer over a course name to display the full course title. 

To print from the Calendar view, click the Print button in the lower right corner of the page. 

Notes View 
The Notes view will display a student’s plan in a list format with any notes and placeholder comments associated with 

each term and course. Notes and comments are added in the Edit view. The notes and placeholder comments can be 

toggled between hidden or shown by clicking the Hide all notes or Show all notes button. 
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Audit View 
The Audit view combines the Calendar view and the Planner worksheet on the same page. Use this view after creating a 

plan in Edit view.  

 

The Calendar area of the Audit view allows listed courses to be relocated among the available terms by drag-and-drop. 
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Notes Tab 
The Notes tab is used to enter general notes on the student whereas notes added in the Edit view are specific to a plan, 

term, or course. 

\ 

Click the Add Note link to add a note on the student. Choose a predefined note or type a custom note in the space 

provided. Click the Save Note button when finished. 

 

To modify a saved note, click on the Modify Notes link and make edits within the text box containing the note. Click the 

paper/pencil icon to save the newly edited note. A message will appear to confirm edits are saved. 

 

To delete a saved note, click on the Delete Notes link. Find the note to delete and click on the paper/pencil icon. A 

message will appear to confirm the note deletion. 

Note: Saved notes in a student plan can only be deleted by the original author. 
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Petitions Tab 
The Petitions tab will list all student petitions for changes in a plan. Petitions can be added, modified, or deleted from the 

student record as needed. 

 

Click the Add Petition link to add a new student petition. Provide details on the petition in the space provided and click 

Submit Petition when finished. 

 

To modify an existing petition waiting for approval, click on the Modify Petition link and make edits within the text box 

containing the petition. Click the paper/pencil icon to save the newly edited petition. A message will appear to confirm 

edits are saved. 

 

To delete an existing petition waiting for approval, click on the Delete Petition link. Find the petition to delete and click 

on the paper/pencil icon. A message will appear to confirm the note deletion. 

 

 

 


